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Introduction
What you can learn in this document

 Learn more about what’s on your PC
 How to organize your hard drive to minimize data loss or disaster
 Creating folders and sub-folders
 Backing up your Operating System and the rest of your stuff
 How to re-partition a hard drive if you so choose
 Backing up your email and addresses

What do manufactures provide with your new PC?
No longer do manufactures provide a Windows Disc. Usually, a hidden partition is provided containing the files
to restore your PC to factory conditions. You very rarely want to do this since you would have to spend several
hours at a minimum to reconfigure your PC to the way you want it.

Also, this hidden partition takes up extra space and it could get corrupted. If your PC can no longer boot, you
need a strategy to get your PC running to the point where it can access this hidden partition. Manufactures
usually provide instructions or a program to create recovery media for this purpose. You can also create an
emergency boot disk or recovery drive.

Using the manufacturing supplied tools takes much longer than 3rd party (often free) software and I don’t
recommend relying on it.

What is and what is not on your PC’s hard drive when you first purchase it?
 Usually one very large hard drive
 An operating system that’s at least 6 months out of date
 An outdated or trial version of an antivirus
 Unwanted software
 None of your favorite programs
 No email or contacts unless you use Web mail
 None of your settings, Screen Saver, Desktop icons and shortcuts
 iTunes Library, etc.
 A Recovery Partition so you can restore you PC to this miserable state if it crashes
 No User accounts
 No Power Options (usually for a Laptop)
 No Browser plugins such as Flash
 No printer
 Possibly no Adobe Reader
 No Internet Favorites

Note: You have the same situation if you have to reinstall Windows or restore your PC after a crash.
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What happens to our PC as we use it?
 It slows down due to too many startup programs
 Lots of fonts have an effect also
 None of us can resist all email, all attachments nor all of those free toolbars
 It gets gummed up – we forget to do housecleaning periodically
 It can be cleaned up – but – if it took you a year or more to mess it up, it can’t be fixed in 10 or 20

minutes – or can it?

Why bother to backup your PC?
1. If your PC crashes due to corrupted files, malware or a visit from the grandkids it could take several

hours or more to get back up and running. Or, you could restore an image and be running in 20
minutes.

2. With threats like RansomeWear or CryptoLocker spreading, it’s imperative that all of your data be
backed up to a device that is not connected to your PC. Read more about RansomeWear here. Here
are some options to protect your data:

a. Backup to an external hard drive and then disconnect it
b. Use a service like Carbonite
c. Use free services such as SkyDrive or DropBox

What needs to be backed up?
 The Operating System (Windows)
 Installed programs – only using a disk image. You can always reinstall the programs if you have the

media.
 Data including documents, photos, music, etc.
 iTunes Library (I move my Library to a 2nd hard drive see next section
 Internet Favorites
 If you use a password manager such as RoboForm, you need to back up your password data files.

When I used RoboForm, I always backed up my data to a 2nd hard drive which made it easier.
 Any other mobile data from your iPad, etc.
 Email and Contacts (you can change the location of Windows Live Mail folders) – see section later on.

You should back up your contacts even if you use Web mail in case your email account gets
compromised.

Relocating your iTunes Library
See the article at http://www.ilounge.com/index.php/articles/comments/moving-your-itunes-library-to-a-
new-hard-drive/

Why do most people fail to backup?
 They think it will never happen to them (PC crashes)
 Laziness
 Afraid to tackle the job
 Believe they have nothing to backup (what about if Windows crashes?)

http://www.edwardns.com/site/ransomeware
http://www.ilounge.com/index.php/articles/comments/moving-your-itunes-library-to-a-new-hard-drive/
http://www.ilounge.com/index.php/articles/comments/moving-your-itunes-library-to-a-new-hard-drive/
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 Need some encouragement and tutorials

What skills do you need?
 Be able to create folders
 Download and install software
 Follow directions (included here)
 Be able to create an emergency boot disc
 Be able to boot from a CD, DVD or USB
 Connect an external hard drive

Typical setup
All you need is an external hard drive, an imaging program and a CD burned by the imaging software. Once you
install the program to create the CD, you probably will not use the program again.

Theory
You should make an image of your PC every one to two months and backup your data frequently. You should
only save the last several images to prevent filling your external hard drive or wherever you store them.

Before you backup
Since you want your backup to be clean and up to date you should perform the following prior to creating a
backup image:

1. Run Ccleaner
2. Make sure that Windows has the latest updates
3. Run an antivirus scan and an anti-malware scan

Typical scenario
You create an image on January 1st and you crash March 1st. If you restore the January 1st image, you will only
lose 2 months of data unless you backup your data frequently. You will still have to update Windows and your
antivirus software.
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Organizing you hard drive
Your PC most likely has only one hard drive, your C Drive. Some PCs have more than one hard drive or have
their C Drive partitioned.

Here’s a map of the hard drives on my Windows 7 desktop. There are 4 physical drives with a total of 6
partitions.

Here’s a map of the drives on my Windows 8 Notebook. Notice the Recovery partition. There is only 1 physical
drive with a total of 5 partitions.

If you store a lot of photos on your hard drive your backup images will take longer to create and require more
storage space. Also, try to keep as much data including your iTunes Library and Windows Live Mail folders in an
alternate location away from your C Drive (discussed below)

Backing up your data
 Most software that comes with an external hard drive is poorly done
 I personally use Genie Backup Manager 9 for backing up data – see

http://www.genie9.com/home/home_solutions.aspx
 You can read about a free program here
 There are free programs avail also – see http://www.techsupportalert.com/best-free-backup-program

http://www.genie9.com/home/home_solutions.aspx
http://www.edwardns.com/handouts_Jan_2012/Backup up ypur PC step by step.pdf
http://www.techsupportalert.com/best-free-backup-program
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Repartitioning your hard drive
Using the built-in Windows diskmgmt tool

 First of all go to “Start” and then on the window that appears search for ”Computer ” and then once
you right-click on it another window opens and then you should navigate to the option “Manage “.

 At once a new window will open entitled “Computer Management“. In this new window click on
“Storage” and then go to “ Disk Management “.

 The completion of the second step will give you a view of all the drives present in your computer.
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 Among these select the one you want to partition. Then right-click on the selected drive and navigate
to the option” Shrink Volume “.

 A new window should open in which the size of the drive before shrink will be mentioned and the
available space to shrink will be mentioned , and in the next line you will be asked to enter the amount
of space you want to shrink and this will be the size of the new partition.

Caution: The space you enter must be within the limit of the available space displayed above.
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 After entering the values click on the option “Shrink ” and wait for the process to complete. The time
taken for the operation may be long depending upon the size of the disk and the space to be shrunk.
Once the operation is completed a window appears showing unallocated space and the value is exactly
the one you entered earlier. Select this unallocated space and on right clicking on it click on the option
“ New Simple Volume “.

 A wizard will open up. Go through the wizard and fill in the values required. Usually the value needed
to enter is the same one that you entered as the volume to be shrunk.

 The drive newly created needs a letter to be assigned to it. Assign any letter of your choice as it does
not make any difference.

 A Format page will appear and in it carefully notice that the File System selected is “NTF ” . After this is
done enter a name for your drive and then click on” Next ” and then “ Finish “.
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You have reached your goal. You have partitioned your Hard Drive in Windows 7 without formatting
your computer and without the use of any software. Feel free to drop your comments in the comment
box.

The complete video tutorial:

Partition Hard Disk without Formatting [Screencast]

Using 3rd party software
There are good tools at EaseUS and MiniTool. Both of the companies provide free versions. MiniTool will be
demonstrated in class.

There is a good comparison between the Windows tool and 3rd party software at http://www.partition-
tool.com/resource/windows-8-partition-manager/windows-8-disk-management.htm.  One feature not
mentioned in the previous site is that most 3rd party programs allow you to explore hidden partitions. You
know how curious you are?

Steps to backup or create an image of your hard drive
Preparation

1. Gather what you need
a. An image creating program such as Paragon Backup 2012 Free
b. An external hard drive
c. Blank CD or Flash Drive (2GB or more)
d. Recovery media – see Step 5

http://www.youtube.com/watch?v=7JV4HpJNgGs&feature=player_embedded
http://www.partition-tool.com/resource/windows-8-partition-manager/best-free-partition-manager-for-windows-8.htm
http://www.partitionwizard.com/partitionmanager/windows-8-partition-manager.html
http://www.partition-tool.com/resource/windows-8-partition-manager/windows-8-disk-management.htm
http://www.partition-tool.com/resource/windows-8-partition-manager/windows-8-disk-management.htm
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2. Get your PC exactly the way you want it – remember – garbage in garbage out.
a. Run Ccleaner
b. Scan drive with your anti-virus

3. Create a folder to store the image on your external hard drive. I usually create a folder with a name
such as “Images Ed’s Toshiba”. Then create a subfolder with the date you plan to create the image.

4. Download and install Paragon software
5. Create Recovery Media – see separate section
6. Give all your hard drives a name. Open My Computer, right-click the C Drive and select Properties and

enter a name such as C_Drive (no spaces allowed). This is necessary since recovery software labels the
drives differently than Windows does.

Creating Recovery Media
1. Download and install Paragon Recovery 2012 Free from http://www.paragon-software.com/home/br-

free. You may have to register with an email address to obtain a free installation code.
2. Insert a blank CD into your CD/DVD drive

http://www.paragon-software.com/home/br-free
http://www.paragon-software.com/home/br-free
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3. Launch the program and click Tools.

4. Click Burn Recovery Media
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5. Click Next

6. Click next and select CD/DVD



Page 13 of 22

7. Click Next and select Typical

8. Select your CD drive and click Next

9. Click Next until the creation process begins
10. Remove and label the CD you just created.
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Creating the image
Preparing to backup

1. Connect your external hard drive unless you’re using a 2nd hard drive or 2nd partition
2. Create a folder called Images which will contain the backup image
3. Create a sub-folder in that same folder named Image 11_27_12 (use current date)
4. See document here for the balance of the steps/

Disk imaging programs

Free
Paragon http://www.paragon-software.com/home/br-free/download.html
Macrium Reflect http://www.macrium.com/reflectfree.aspx
There are other free programs also

Paid
Acronis True Image 2012http://www.acronis.com/products/#home ($39.99 on Amazon)
ShadowProtect http://www.storagecraft.com/ ($89.95)

Test results
All work with Windows XP and Windows 7
Tested with Windows 8 – Acronis True Image

Acronis True Image 2013 OK on my desktop PC and laptop
Shadow Protect Desktop 4 OK on my desktop PC but not on my laptop
Paragon 2012 Free OK on my desktop PC but not OK yon my laptop

Backup Windows Live Mail?

If you need to switch hardware or re-install Windows Live Mail, it’s a good idea to first export
everything, make the change, and then re-import everything. This is commonly known as a backup and
restore.

If you’ve added email accounts to Windows Live Mail, most of these accounts automatically save your
messages and will sync them when you add the account again.

Before you begin

 If exporting your mail, create a new folder in the location of your choice. Messages must be
exported to an empty folder.

 Calendar items cannot be backed up. However, if you sign in with a Windows Live ID, then
your calendar will be synced with http://calendar.live.com.

 If you sign in with a Windows Live ID, your contacts will sync automatically. If you don’t sign
in with a Windows Live ID, then your contacts must be manually exported and re-imported.

http://www.edwardns.com/handouts_Jan_2012/Backup up ypur PC step by step.pdf
http://www.paragon-software.com/home/br-free/download.html
http://www.macrium.com/reflectfree.aspx
http://www.acronis.com/products/
http://www.storagecraft.com/
http://go.microsoft.com/fwlink/?LinkId=136305
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 If you have a POP3 account, check the Advanced tab in Properties to see if messages are
removed from the POP3 server. If they are and you plan to uninstall or remove that account
from Windows Live Mail, you should manually export and re-import your messages.

 If you are using a program like Windows Easy Transfer, make sure you include your newly
created folders in your backup. Details on using Windows Easy Transfer can be found here.

 If importing multiple contacts, it is better to use .csv. Importing .vcf files needs to be done one
at a time.

To export email messages from Windows Live Mail

1. Open Windows Live Mail by clicking the Start button. In the search box, type Mail, and then, in the list
of results, click Windows Live Mail.

2. In the upper-left corner, open the File menu, click Export email, and then select Email messages.

3. Select Microsoft Windows Live Mail as the export format, and then click Next.
4. Click Browse and browse to where you want to store the messages. Verify that the folder is

empty.
5. Click Next.
6. Select the message folders that you want to export, and then click Next. You will get a

confirmation that the messages were successfully exported. Click Finish.

To export contacts from Windows Live Mail

1. Open Windows Live Mail by clicking the Start button. In the search box, type Mail, and then, in the list
of results, click Windows Live Mail.

2. In the lower-left corner, select Contacts.
3. Click Export on the ribbon.

http://go.microsoft.com/fwlink/?LinkId=160881
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4. Select a file format in the drop-down menu.
o If exporting multiple contacts, select .csv.
o If exporting only one or two contacts, select .vcf.

5. Click Browse and select where to save your contacts.
6. Enter a file name and then click Save.
7. Click Next, and then select the check boxes next to the fields that you want to export. Only

selected fields are exported, so make sure to select everything you might want later.
8. Click Finish.

To import email messages into Windows Live Mail

1. Open Windows Live Mail by clicking the Start button. In the search box, type Mail, and then, in the list
of results, click Windows Live Mail.

2. In the upper-left corner, open the File menu, and then click Import messages.

3. Select the appropriate file format and then click Next. (Options include Microsoft Outlook
Express 6, Windows Live Mail, and Windows Mail.)

4. Click Browse and select the folder containing your exported messages, and then click Next.
You can choose to import all the folders or only specific folders.

5. Click Next. You will get a message confirming the file format used and that the import was
successful.

6. Click Finish. You can find the imported messages in the left pane, in a folder named Storage
folders.

To import offline contacts into Windows Live Mail

1. Open Windows Live Mail by clicking the Start button. In the search box, type Mail, and then, in the list
of results, click Windows Live Mail.

2. In the lower-left corner, select Contacts.
3. Click Import on the ribbon.
4. Select the file format that matches your exported contacts (.csv or .vcf).
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5. Click Browse and then select the folder containing your exported contacts.
6. Click Next and select the check boxes next to the fields that you want to import.
7. Click Finish.

Placing your Windows Live Mail folders in an alternate location
1. Create a folder in your alternate destination
2. Open WLM and click on the WLM icon (just left of the Home tab) on the Menu Bar.
3. In the pop up menu, select Options / Mail.
4. In the Options window, select the Advanced tab.
5. Under Maintenance and Troubleshooting, click on the Maintenance box.
6. In the maintenance window, click on the Store Folder box.
7. In the Store Location window now displayed, click on the 'Change' box and select the alternate

location.

Using System Restore

System Restore can be useful - but it's important to note its main limitations:

1. It doesn't back up your user files and documents. System Restore focuses on system-level files and
services; it doesn't back up most files you create. If you munge or permanently delete an important
document or spreadsheet, or want to go back to an earlier version of such a document, System
Restore can't help you. System Restore doesn't take the place of full, normal backups.

2. System Restore isn't a true "roll back" tool. For example, if you install new software that crashes badly,
System Restore may be able to get Windows running again, but may not erase the errant program as a
whole; may not delete leftover vestiges of the program that failed to uninstall properly; and may not
clean up any messes the troublesome program made outside of the system file areas.>

3. The default settings make System Restore an enormous space hog. For reasons known only to the
programmers at Microsoft, System Restore, like the Recycle Bin and the Internet Explorer cache, sets
aside space for itself based on a percentage of what's available on your hard drive. This might not have
been too bad when disks were small, but with today's large hard drives, the total space set aside for
System Restore (and Recycle Bin and the IE cache) can be ridiculous: It can amount to gigabytes in
total! This not only consumes disk real estate, but also creates a huge amount of needless extra data
you have to process when you do a normal backup.

4. System Restore doesn’t usually bail you out from a virus or spyware. Some malware will infect System
Restore points or actually delete all of you Restore Points.

System Restore is no substitute for regular backups. And if you do make regular backups, as you should, then
you really don't need System Restore at all. You can turn it off -- saving CPU cycles and disk space. Making
regular backups in this case includes making an image of your hard disk.

Using Manufacturer’s Restore Media
Frequently, a manufacturer will tell you to restore your PC to its original state using the restore media to
resolve a problem. In many cases this is a lazy way out for the manufacturer. When you do this you could lose
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all of your data including email and email addresses. You actually restore your PC to the state it was in when
you bought it. This means that you have to reinstall all of your software, antivirus program and configure your
PC the way you like it. This can take several hours at least.

This should always be done as a last resort. A better way of protecting yourself is to create an image of your
system and store it on a 2nd hard drive or external drive.
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Windows 8 Backup and recovery

Using the Windows 8.1 built-in recovery tools
First of all you can no longer create a recovery CD or DVD with Windows 8.1 but you can create a Recovery
Drive on a USB drive.

You can do this 2 ways with Windows 8.1 as follows:
1. Open the Control Panel and select File History or from the Start Screen type File History. Both of these

are shown below.
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2. The screen as shown below will open

3. Select System Image Backup to create an image of your PC. In order to use this to restore you have to
boot from a Recovery Drive. To create this drive, insert an empty USB drive and click Recovery as
shown above.

4. If your PC becomes inoperable just boot from the USB Flash Drive and restore the image.
You can read more here.

Windows 8 Refresh and Reset
You can read about it here. But before you do anything you should understand the following:

1. Either of these methods will require that you reinstall all of your software, update Windows, etc.
2. If your PC cannot boot into Windows you will have to use the Recovery Drive to boot your machine.

You did make one didn’t you?
3. I believe that if your PC came with Windows 8 and you updated to 8.1, a Refresh or Reset to take you

back to Version 8. I can’t get a straight answer from Microsoft but this is what I believe.

http://www.eightforums.com/tutorials/2269-system-recovery-options-boot-windows-8-a.html
http://winsupersite.com/windows-8/windows-8-tip-reset-or-refresh-your-pc
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This is why I prefer disc imaging to using the Microsoft tools.

Backing up files with Windows 8 File History
Windows 8.1 can back up your files using File History. You have to enable it and it doesn’t do very much except
backup and restore your user data files. You can read about it here.

Using 3rd party tools to backup Windows 8

I’ve tried many imaging programs but the only one that seems to work with Windows 8 notebooks is Acronis
True Image. With a Desktop I’ve tried several and they all work. Always download a trial version first unless it’s
freeware. Make sure it works before you depend on it.

Note – to boot from an Acronis True Image recovery disc you may have to turn off Secure Boot in your PCs
BIOS.

What tasks should you do?
1. Start by reading the article here. It specifically covers Windows 7. This article covers the Windows 7

built-in backup tools which I avoid but feel free to try them.
2. Backup your data regularly to at least 2 different places using any of the following methods..

a. Use a Backup program such as Genie Backup Manager Home or similar. I use this. It has a
scheduler so you can backup as frequently as needed.

b. Use an online service such as Carbonite which I use
c. Use Windows File Manager (you have to remember to do this).
d. Use an online syncing service such as DropBox or SkyDrive and keep your most valuable data

here. This isn’t the best way to backup a lot of pictures, videos or music since it will take up
more space that the service’s free subscription will allow. I use SkyDrive.

3. Backup the following if required:
a. Internet Favorites
b. Email addresses and messages unless you use Webmail such as Gmail.
c. Passwords but not on your hard drive unless encrypted. If you use RoboForm your passwords

are stored on your PC. If your PC becomes inoperable or is stolen you will lose your passwords
unless you use RoboForm Everywhere.

4. Create a backup image of your hard drive in case your PC gets infected or corrupted. You can use
Acronis True Image or the free Paragon Backup software. Both programs allow you to create an
emergency boot disc so you can restore an image to a inoperable PC. You should do this every few
months at least but you only need to store the 2 most recent images. The Paragon Manual can be
found here. Look for the Acronis manual here.

Other things to do
1. Backup you PCs data or system image to an external hard drive and keep it in a secure place
2. Examine your external hard drive periodically to make sure your backup is working
3. If you use an online backup service, log on periodically to check on it.
4. I recommend weaning yourself away from Windows built-in backup tools since I predict they will

eventually disappear.

http://windows.microsoft.com/en-us/windows-8/how-use-file-history
http://www.edwardns.com/handouts_Oct_2013/Build a complete Windows 7 safety net.pdf
http://www.paragon-software.com/home/br-free/download_manual.html
http://www.acronis.com/products/
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5. Create a Windows 7 Repair Disc. See information here.

Final recommendations
 I usually avoid Microsoft built-in software
 Find a method to back up your stuff and stick with it
 Make a Recovery Disc or Recovery Drive and keep it in a safe place
 Make an image of your hard drive using an external hard drive

o I use Shadow Protect for this. It’s the best but it costs $89. A good alternative is Acronis True
Image for $49 or Paragon Backup for free.

Resources
Here’s a few links on the subject for your perusal.
http://edwardns.com/blog/which-disk-imaging-program-should-i-use
http://edwardns.com/blog/backup-a-new-pc
http://en.wikipedia.org/wiki/Disk_image
http://www.techsupportalert.com/best-free-drive-imaging-program.htm
http://www.edwardns.com/castapcclub.html see Backing Up Overview and Step by Step
http://edwardns.com/blog/checklist-for-backing-up
http://www.edwardns.com/SJC%20Classes.html see Caring for your PC near the bottom of the page
http://lifehacker.com/292972/partition-and-image-your-hard-drive-with-the-system-rescue-
cd?tag=softwaregeektolive
http://www.paragon-software.com/home/br-free/download_manual.html Paragon Manual
http://www.dedoimedo.com/computers/paragon-backup.html Paragon Tutorial
http://www.tweakhound.com/xp/backup/diskimage.htm Acronis tutorial
http://www.pcworld.com/article/146367/diversifybackups.html?page=0 PC World article
http://www.pcworld.com/article/186735/hasslefreepc.html PC World article
http://www.thefreecountry.com/utilities/backupandimage.shtml Good article
http://www.backup4all.com/kb/backup-types-115.html Backup types

http://windows.microsoft.com/en-us/windows7/create-a-system-repair-disc
http://edwardns.com/blog/which-disk-imaging-program-should-i-use
http://edwardns.com/blog/backup-a-new-pc
http://en.wikipedia.org/wiki/Disk_image
http://www.techsupportalert.com/best-free-drive-imaging-program.htm
http://www.edwardns.com/castapcclub.html
http://edwardns.com/blog/checklist-for-backing-up
http://www.edwardns.com/SJC Classes.html
http://lifehacker.com/292972/partition-and-image-your-hard-drive-with-the-system-rescue-cd?tag=softwaregeektolive
http://lifehacker.com/292972/partition-and-image-your-hard-drive-with-the-system-rescue-cd?tag=softwaregeektolive
http://www.paragon-software.com/home/br-free/download_manual.html
http://www.dedoimedo.com/computers/paragon-backup.html
http://www.tweakhound.com/xp/backup/diskimage.htm
http://www.pcworld.com/article/146367/diversifybackups.html?page=0
http://www.pcworld.com/article/186735/hasslefreepc.html
http://www.thefreecountry.com/utilities/backupandimage.shtml
http://www.backup4all.com/kb/backup-types-115.html
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